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Disclaimer of Product & Services 
The information offered in this instruction manual is intended as a guide only. At all times, 
Datavideo Technologies will try to give correct, complete and suitable information. However, 
Datavideo Technologies cannot exclude that some information in this manual, from time to time, 
may not be correct or may be incomplete. This manual may contain typing errors, omissions or 
incorrect information. Datavideo Technologies always recommend that you double check the 
information in this document for accuracy before making any purchase decision or using the 
product. Datavideo Technologies is not responsible for any omissions or errors, or for any 
subsequent loss or damage caused by using the information contained within this manual. Further 
advice on the content of this manual or on the product can be obtained by contacting your local 
Datavideo Office or dealer. 
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FCC Compliance Statement 

This device complies with part 15 of the FCC rules. Operation is subject to the following two 
conditions: 

1. This device may not cause harmful interference, and  

2. This device must accept any interference received, including interference that may cause 

undesired operation. 

Warnings and Precautions 

1. Read all of these warnings and save them for later reference. 

2. Follow all warnings and instructions marked on this unit. 

3. Unplug this unit from the wall outlet before cleaning. Do not use liquid or aerosol 

cleaners. Use a damp cloth for cleaning. 

4. Do not use this unit in or near water.  

5. Do not place this unit on an unstable cart, stand, or table. The unit may fall, causing serious 

damage. 

6. Slots and openings on the cabinet top, back, and bottom are provided for ventilation. To ensure 

safe and reliable operation of this unit, and to protect it from overheating, do not block or 

cover these openings. Do not place this unit on a bed, sofa, rug, or similar surface, as the 

ventilation openings on the bottom of the cabinet will be blocked. This unit should never be 

placed near or over a heat register or radiator. This unit should not be placed in a built-in 

installation unless proper ventilation is provided. 

7. This product should only be operated from the type of power source indicated on the marking 

label of the AC adapter. If you are not sure of the type of power available, consult your 

Datavideo dealer or your local power company. 

8. Do not allow anything to rest on the power cord. Do not locate this unit where the power cord 

will be walked on, rolled over, or otherwise stressed. 

9. If an extension cord must be used with this unit, make sure that the total of the ampere ratings 

on the products plugged into the extension cord do not exceed the extension cord rating. 

10. Make sure that the total amperes of all the units that are plugged into a single wall outlet do 

not exceed 15 amperes. 

11. Never push objects of any kind into this unit through the cabinet ventilation slots, as they may 

touch dangerous voltage points or short out parts that could result in risk of fire or electric 

shock. Never spill liquid of any kind onto or into this unit. 

12. Except as specifically explained elsewhere in this manual, do not attempt to service this 

product yourself. Opening or removing covers that are marked “Do Not Remove” may expose 

you to dangerous voltage points or other risks, and will void your warranty. Refer all service 

issues to qualified service personnel. 

13. Unplug this product from the wall outlet and refer to qualified service personnel under the 

following conditions: 

a. When the power cord is damaged or frayed; 

b. When liquid has spilled into the unit; 

c. When the product has been exposed to rain or water;  
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d. When the product does not operate normally under normal operating conditions. Adjust 

only those controls that are covered by the operating instructions in this manual; improper 

adjustment of other controls may result in damage to the unit and may often require 

extensive work by a qualified technician to restore the unit to normal operation; 

e. When the product has been dropped or the cabinet has been damaged; 

f. When the product exhibits a distinct change in performance, indicating a need for service. 

Warranty 

Standard Warranty 

• Datavideo equipment is guaranteed against manufacturing defects for one (1) year from the 

date of purchase. 

• A valid purchase invoice or other proof of purchase must be provided when requesting 

warranty service. 

• The warranty period begins on the actual purchase date. If the purchase date cannot be 

verified, the warranty period will begin thirty (30) days after shipment from a Datavideo 

office. 

• Non-Datavideo branded products (products without the Datavideo logo) are covered by a 

one-year warranty from the date of purchase. 

• Damage caused by accident, misuse, unauthorized repair, or exposure to sand, grit, or water is 

not covered under warranty. 

• Virus or malware infections on computer systems are not covered under warranty. 

• Any issues caused by unauthorized third-party software installations that are not required by 

Datavideo systems are not covered under warranty. 

• All shipping, mailing, or transportation costs, including insurance, are the responsibility of the 

owner unless otherwise stated. 

• Teleprompter glass is not covered under warranty. 

• Accessories, including headphones, cables, batteries, metal parts, housings, protective cases, 

cable reels, and consumable items, are not covered under warranty. 

• Warranty is valid only in the country or region of purchase. 

• All other claims not explicitly stated are not covered. 

• Your statutory rights remain unaffected. 

Five Year Warranty 

• Starting January 1, 2026, all Datavideo products that are successfully 

registered on the Datavideo official website are eligible for a free four-

year extended warranty, in addition to the standard one-year warranty, 

for a total of five years of coverage.  

• Only registrations completed through the Datavideo official website qualify for the five-year 

warranty. Registrations completed through local Datavideo offices, resellers, or authorized 

distributors are not eligible. 

• Certain parts with limited service life — including LCD panels, DVD drives, hard drives, solid-

state drives, SD cards, USB thumb drives, lighting equipment, non-PCIe cards, and third-
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party PC components — are covered by a one-year warranty only and are not eligible for the 

extended warranty. 

• Camera modules are covered by a three-year warranty from the date of purchase. 

Disposal 

For EU Customers only - WEEE Marking 

This symbol on the product or on its packaging indicates that this product must 

not be disposed of with your other household waste. Instead, it is your 

responsibility to dispose of your waste equipment by handing it over to a 

designated collection point for the recycling of waste electrical and electronic 

equipment. The separate collection and recycling of your waste equipment at 

the time of disposal will help to conserve natural resources and ensure that it is recycled in a 

manner that protects human health and the environment. For more information about where you 

can drop off your waste equipment for recycling, please contact your local city office, your 

household waste disposal service or the shop where you purchased the product. 

CE Marking is the symbol as shown on the left of this page. The letters "CE" are 

the abbreviation of French phrase "Conformité Européene" which literally 

means "European Conformity". The term initially used was "EC Mark" and it was 

officially replaced by "CE Marking" in the Directive 93/68/EEC in 1993. "CE 

Marking" is now used in all EU official documents. 
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1. Introduction 
 

The TLM-170K offers a UHD 3840 x 2160 LCD Panel which provides a wide viewing angle of 178°, 

300 cd/m² brightness, and 1000:1 contrast ratio. It features a 12G SDI input and two HDMI 2.0 

inputs with one loop through output allowing connection of up to DCI 4K and Ultra HD video 

sources. 

The TLM-170K is equipped with various functions such as waveform, vector scope, false color filter, 

histogram, peaking filter, zoom, screen markers, etc. The TLM-170K has two HDR transfer functions 

which are HLG and SMPTE 2084. The color space includes options such as Rec 709 and DCI P3 

Cinema. The TLM -170K is designed specifically for broadcast and field production applications. 

Features 

• DCI 4K/60p and UHD 4K/60p videos for both input and output 

• 17” monitor with UHD 4K (3840 x 2160) LCD display 

• Supports column (YRGB peak), time code, waveform, vector scope & audio level meter, peaking 

filter, zoom, pix to pix, overscan, check field, etc 

• 12G-SDI video input with loop-through output 

• HDMI 4K input with loop-through output 

• Time Code Display (LTC/VITC) 

• Four user-assignable function keys (F1, F2, F3, and F4)  

• Safety Marker and Aspect Marker 

• 1000:1 contrast ratio, 300 cd/m² brightness 

• 178° Horizontal & Vertical wide viewing angle 

• Individual adjustments of Brightness, Contrast, and Saturation. 

• Color Match Conversion with Color Temperature Adjustment 

• Front panel Headphone Jacks 

• Tally light included.  

Model Types 

Model TLM-170K TLM-170KR TLM-170KM 

Image 

 
  

System Desktop 7U Rack Mount 1U Mobile Tray Rack 
Mount 
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2. Assembling 
 
If you would like to rest the monitor in an upright position on a flat surface, simply use the two 

riser blocks provided. Follow the steps outlined below to mount the monitor to a flat surface.  

Step 1 
Make sure you have all the parts listed in the table below in the product package. If you find 

missing items, please contact local Datavideo office or distributors.   

No. Part Name Part No. Q’ty Use 

1 Nylok Screw ISO Truss Head M4.0*8m/m 
Black (RoHS) 

G0911D400811 4 Secure the 
monitor to riser 
blocks 

2 Truss Head Self-Drilling Screw 
φ5.0*15m/m Nickel Plated  

G09111501503 4 Secure riser 
blocks to the desk 

3 VP-927 TLM-170K Riser Block G13309271201 2  
 

Step 2 
Insert the monitor to the two riser blocks as shown in the diagram below then secure with truss 

head nylok screws (G0911D400811).  
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Step 3 
As shown in the diagram below, use the truss head self-drilling screws (G09111501503) to secure 

the riser blocks to the desk.    
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3. Connections and Controls 

Front Panel 

 
 

 

 
 

Buttons Descriptions 

 

Power ON/OFF 
This button powers the monitor ON/OFF. The main power switch 
is located at the rear of the TLM-170K.  

 

SDI Button 
Press once to enable the SDI video source on the monitor screen. 
You can connect the loop thru port (see Rear Panel) to a monitor 
to view the activated input video source. 
 
As the SDI video source is activated, the button LED will be turned 
ON. 

Dual Color Tally Light 

Video Source 
MENU 

Activation  Return/EXIT 

Headphone Audio Volume 
Control 

Power 
ON/OFF 

Shortcut Keys 
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HDMI 1/2 Button 
Press once to enable the HDMI video source on the monitor 
screen. Please note that the two video sources cannot be 
enabled at the same time. You can connect the loop thru port 
(see Rear Panel) to a monitor to view the activated input video 
source.  
As the HDMI video source is activated, the corresponding button 
LED will be turned ON. 

 

MENU Button 
Press the MENU button to open the OSD menu. Once in the OSD 
menu, press the MENU button to make a selection.  
 

 

Audio Volume Adjustment Buttons 
Once in the OSD menu, navigate the menu or increase/decrease 
parameter values using the audio volume adjustment buttons. 
 
While NOT in the OSD menu, pressing either one of the audio 
volume adjustment buttons will open a Volume slide bar at the 
bottom of the screen. Then press the MENU button to switch to 
other setting options as listed below:  

• Volume 

• Brightness 

• Contrast 

• Saturation 

• Tint 

• Sharpness 

• Exit 
 
To adjust the parameter values, simply press the Vol- arrow 
button to decrease the value and the Vol+ arrow button to 
increase the value.  

 

EXIT Button 
Return/Exit button 

 

 

F1 – F4 Shortcut Keys 
Press the F1-F4 shortcut keys to access the corresponding 
function setting menus. The default function setting menus are 
shown as follows:  
F1: Scan 
F2: Waveform 
F3: Aspect 
F4: Aspect Marker 
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Customization of Button Functions 
The user is allowed to customize or re-assign function setting 
menus to the F1-F4 shortcut keys. The customization steps are 
outlined as follows:  
1. First press and hold one of the shortcut keys (F1-F4) for 
approximately 3-5 seconds until a pop-up function list appears on 
the monitor.  
2. Press the left and right arrow keys of the audio volume 
adjustment buttons to move between options in the pop-up 
function list.  
3. Press the menu button to assign the highlighted function 
setting menu to the shortcut key selected at step 1.  
4. Press the EXIT button to close the pop-up function list.  
 
The pop-up function list is shown below:  

• Center Marker 

• Aspect Marker 

• Safety Marker 

• Overscan 

• Scan 

• Aspect 

• Color Space 

• Gamma 

• Camera Log 

• Check Field 

• H/V Delay 

• Freeze 

• Color Bar 

• False Color 

• Exposure 

• Histogram 

• Waveform 

• Vector 

• Time Code 

• Mute 

• Level Meter 

• Audio Vector 
 
Button Reset 
To reset F1-F4 buttons to factory defaults, follow the steps 
outlined as follows: 
 
1. Open the OSD menu, and navigate to SYSTEM.  
2. Press the MENU button to enter the SYSTEM sub menu.  
3. Move down to the RESET option which is selected by pressing 

the MENU button.  
4. Press either the VOL+ or VOL- button to enable the reset.  

 
Note: The reset function resets all TLM-170K settings. 
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Headphone Jack 
Once the 3.5mm headphone jack is connected, the internal 
speaker will be automatically muted.   

Rear Panel 

 

Ports Descriptions 

3.5mm Tally Light Input 
Tally light input. The tip, ring and sleeve of the phone jack should 
be connected to tally red, tally green and the ground.   

Loop Thru Output A loop thru output of SDI and HDMI inputs.  

HDMI Input 1/2 
Connect HDMI video and audio source devices.  
HDMI 1: YUV420 not supported 
HDMI 2: YUV420 supported 

USB 2.0 Port (SERVICE) 
For firmware upgrade only; see Firmware Update for more 
information about firmware upgrade.  

SDI Input / Output 1 SDI input/output pair 

DC IN 12V 12 V power input (XLR/Phoenix Terminal) 

Power ON/OFF Switch TLM-170K’s main power ON/OFF switch 

 

SDI Input / Output 

HDMI Input 1 / 2 

USB Port 

DC IN 12V 
(XLR) 

3.5mm Tally light 
input socket 

ON/OFF Switch 

Loop Thru Output 

DC IN 12V 
(Phoenix) 
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4. OSD MENU 

The TLM-170K can be set up using an OSD menu system. To display the OSD menu press the MENU 
button. This menu system is navigated using the Left / Right buttons. The Left / Right buttons are 
also used to change parameter values. Press the MENU button to select an option and the EXIT 
button to close the OSD menu.  

Main Options Sub Options Parameters 

Picture 

Brightness 0 – 100  

Contrast 0 – 100  

Saturation 0 – 100  

Tint 0 – 100  

Sharpness 0 – 100  

HDMI RGB Range 
Full 

 
Limited 

HDMI EDID 
2K 

 
4K 

Color Space 

BT2020 

 

DCI-P3 

EBU 

Rec709 

SMPTE-C 

Native 

Camera Log 

Off 

 Def. Log 

User Log 

Def. Log 

SLog2ToLC-709 

 

SLog2ToLC-709TA 

SLog2ToSLog2-709 

SLog2ToCine+709 

SLog3ToLC-709 

SLog3ToLC-709TA 

SLog3ToSLog2-709 

SLog3ToCine+709 

ArriLogCTo709 

ArriLogCToP3DCI 

ClogTo709 

VLogToV709 

JLog To709HLG 

JLog To709PQ 

Z7 NLogTo709 

D780 NLogTo709 

User Log 

No Data 

 

User 1 

User 2 

User 3 

User 4 

User 5 
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Main Options Sub Options Parameters 

User 6 

Gamma 

Off 

 

1.8 

2.0 

2.2 

2.35 

2.4 

2.6 

2.8 

HDR 

Off 

 

ST 2084 300 

ST 2084 1000 

ST 2084 10000 

HLG 

Back Light 0 – 100  

Color Temperature 3200°K  

 

5500°K 

 
6500°K 

7500°K 

9300°K 

User Color Red Gain 0 – 255 

 

Green Gain 0 – 255 

Blue Gain 0 – 255 

Red Offset 0 – 511 

Green Offset 0 – 511 

Blue Offset 0 – 511 

Marker 

Center Marker 
ON  

OFF 

Center Marker Size 

Small  

Middle 

Large 

Aspect Marker 

OFF  

16:9 

1.85:1 

2.35:1 

4:3 

3:2 

2.0X 

2.0X MAG 

Grid 

User 

Safety Market 

OFF  

95% 

93% 

90% 

88% 

85% 
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Main Options Sub Options Parameters 

80% 

Marker Color 

Red  

Green 

Blue 

White 

Black 

Aspect Mat 

OFF  

1 

2 

3 

4 

5 

6 

7 

Thickness 

1  

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

User Marker H1 1 – 3840   

User Marker H2 1 – 3840  

User Marker V1 1 – 2160   

User Marker V2 1 – 2160  

Function 

Scan 

Zoom  

Aspect 

Pixel to Pixel 

Aspect 

Full  

16:9 

1.85:1 

2.35:1 

4:3 

3:2 

2.0X 

2.0X MAG 

Overscan 
OFF  

ON 

H/V Delay 
Off  

H 
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Main Options Sub Options Parameters 

V 

H/V 

Check Field 

OFF  

Red 

Green 

Blue 

Mono 

Zoom 

90%  

80% 

70% 

60% 

50% 

40% 

30% 

20% 

10% 

Freeze 
OFF  

ON 

Waveform 

Waveform 

Multi  

Y 

YCbCr 

RGB 

OFF 

Vector 
OFF  

ON 

Transparency 

50%  

25% 

OFF 

Peaking 
OFF  

ON 

Peaking Color 

Red  
 Green 

Blue 

White 

Black 

Peaking Level 0 – 100  

False Color 

OFF  

Default 

Spectrum 

ARRI 

RED 

False Color Table 
OFF  

ON 

Exposure 
OFF  

ON 

Exposure Level 50 – 100 IRE  

Histogram 
OFF  

Y 
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Main Options Sub Options Parameters 

RGB 

Color 

Time Code (SDI) 

OFF  

LTC 

VITC 

Audio 

Volume 0 – 100  

Level Meter 
OFF  

ON 

Audio Vector 
OFF  

ON 

Audio Vector CH 
(HDMI) 

CH 1/2  

CH 3/4 

CH 5/6 

CH 7/8 

Audio Vector CH (SDI) 

CH 1/2  

CH 3/4 

CH 5/6 

CH 7/8 

CH 9/10 

CH 11/12 

CH 13/14 

CH 15/16 

Audio Left Out 
CH1 – 16 (SDI)  

CH 1 – 8 (HDMI) 

Audio Right Out 
CH1 – 16 (SDI)  

CH 1 – 8 (HDMI) 

System 

Language 

English  

Traditional Chinese 

Simplified Chinese 

Color Bar 

OFF  

100% 

75% 

Color Bar Mode 

Rec601  

Rec709 

BT2020 

OSD Timer 

10s  

20s 

30s 

OSD Transparency 

OFF  

25% 

50% 

OSD H Position 0 – 100   

OSD V Position 0 – 100  

Fan 

Auto  

ON 

OFF 

Color Calibration 
OFF 

 
ON 
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Main Options Sub Options Parameters 

Comparison En 

OFF 

 
Gamma&HDR 

Color Space 

Camera Log 

Reset 
OFF 

 
ON 

Picture 

The TLM-170K allows you to adjust the basic image settings such as the brightness, contrast, 
saturation, tint and sharpness.  

Advanced settings are HDMI RGB range, color space, gamma correction, back light mode, back 
light level, and color temperature.  

Brightness 
Adjust the brightness of the screen from 0 – 100. 

Contrast 
Adjust the contrast of the screen from 0 – 100. 

Saturation 
Adjust the saturation of the screen from 0 – 100. 

Tint 
Adjust the tint of the screen from 0 – 100. 

Sharpness 
Adjust the sharpness of the screen from 0 – 100. 

HDMI RGB Range 
This set the HDMI RGB Range. 

RGB Full (0-255): PC Monitor 

RGB Limited (16-235): Standard or HD TVs 

HDMI EDID 
The EDID learning function is only used when you experience any failures in playing audio and 
video correctly. You will be able to force the TLM-170K’s receiving resolution by setting the EDID to 
either 2K or 4K so that the connected HDMI source outputs the maximum resolution defined in 
EDID. 

Color Space 
Select an option from the list below to provide details of the color primaries for interpretation of 
XYZ color space. 

• BT2020 
A 4K RGB color space that has a color gamut that is wider than all other RGB color spaces. 

• EBU 
EBU is another RGB color space encompassing 72% of the NTSC color space. EBU stands for 
the European Broadcasting Union which develops technical standards and regulations for 
broadcasting. DTV standards in Taiwan are developed based on the EBU standards.  
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• REC709 
REC709 is the standard camera encoding color space for HDTV established by International 
Telecommunication Union in 1990.  

• SMPTE-C 
SMPTE-C is the current color standard for broadcasting in America.   

• Native 

Camera Log 
The Camera Log allows you to enable either the connected camera’s Log (Def. Log) or the user 
defined log (.cube file generated by CMS software) imported into the TLM-170K.  

Def. Log 
Rec709 is a color space that produces images that are very normal and realistic with a good 

amount of contrast and saturation. Log footage recorded on cameras is normally colorless so in 

order to color grade your Log footage with the Rec709 color space, you can select the appropriate 

LUT from the list below.  

SLog2ToLC-709 

Sony Log format to Rec709 

SLog2ToLC-709TA 

SLog2ToSLog2-709 

SLog2ToCine+709 

SLog3ToLC-709 

SLog3ToLC-709TA 

SLog3ToSLog2-709 

SLog3ToCine+709 

ArriLogCTo709 
Arri Log format to Rec709 

ArriLogCToP3DCI 

ClogTo709 Canon Log format to Rec709 

VLogToV709 Panasonic Log (Varicam) format to Rec709 

JLog To709HLG 
JVC Log format to Rec709 

JLog To709PQ 

Z7 NLogTo709 
Nikon Log format to Rec709 

D780 NLogTo709 

User Log 
Save color calibration data generated using Light Illusion’s CMS software in .cube files.  

Note: Filming with log allows you to view various color grading generated using different logs on 

the monitor.  
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Gamma 
This sets the gamma correction for the source of input; the smaller the gamma, the brighter the 

screen and vice versa.  

• OFF 

• 1.8 (MAC OS) 

• 2.0 

• 2.2 (Windows) 

• 2.35 

• 2.4 

• 2.6 

• 2.8 

Notes:  

Gamma2.2 is used widely for various applications, providing highlight and shadow enhancement or 

defining a midtone.  

Gamma2.4 is recommended for high quality TV program production and REC709 color space.  

Gamma2.6 is the gamma standard for Digital Cinema Initiative (DCI) and movie filming.  

HDR 
HDR is a new TV video standard that generates higher contrast and wide-gamut images and 

therefore, an HDR monitor is capable of displaying more colors and details of an image than the 

regular ones. The TLM-170K offers two HDR transfer functions listed as follows:  

• ST 2084 or Perceptual Quantizer is able to represent luminance levels of 300, 1000 and 
10000 cd/m2.  

• HLG stands for Hybrid Log-Gamma which is another HDR transfer function.  

Back Light 
Adjust the back light level from 0 – 100.  

Color Temperature 
Select a color temperature for your scene. Color temperatures available on the TLM-170K are listed 

as follows:  

• 3200°K 

• 5500°K (Desktop publishing or printing) 

• 6500°K (Usually for ordinary PC use) 

• 7500°K 

• 9300°K (TV pictures) 

• User Color 

Note: Selection of the User Color mode allows you to manually set the color temperature by 
adjusting the Red Gain, Green Gain, Blue Gain, Red Offset, Green Offset and Blue Offset.  
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Marker 

Aspect ratio is a crucial element in video shooting and it is defined as the proportion of the width 
and height of any image. You can use different aspect ratios in your video. Therefore, in order to 
know what will be in frame at different aspect ratios, during shooting, you can turn on the TLM-
170K’s aspect marker (a.k.a. guide frame) so that you can record the entire screen while still 
knowing where the cut-off will be by putting a mat over it.  

Center Marker 
The Center Marker, if turned on, will place a crosshair in the middle of the screen. 

Center Marker Size 
The Center Marker size can be set to small, medium or large.  

Aspect Marker 
Sets the aspect marker display at the aspect ratio selected from the list below: 

• OFF 

• 16:9 

• 1.85:1 

• 2.35:1 

• 4:3 

• 3:2  

• 2.0X 

• 2.0X MAG 

• Grid 

• User 

 

Safety Marker 
This sets the safety zone display, which is the standard viewing range of the recorded video.  
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The options are listed as follows: 

• OFF 

• 95% 

• 93% 

• 90% 

• 88% 

• 85% 

• 80% 

Marker Color 
The user is also allowed to apply different colors to the aspect marker. The five available marker 
colors are Red, Green, Blue, White and Black. 

Aspect MAT 
This sets the transparency of the mat placed over the cutoff at the select aspect ratio. Select from 
0 to 7 with 7 being an opaque mat and 0 offering the highest transparency.  

 
MAT 7 MAT 6 MAT 4 MAT 2 MAT 0 

 

Thickness 
This sets the aspect marker thickness ranging from 1 to 15.  

User Marker H1/H2 
This adjusts the marker’s horizontal position.  

Increasing the value moves the marker to the right and decreasing the value moves the marker to 
the left.  

User Marker V1/V2 
This adjusts the marker’s vertical position.  

Increasing the value moves the marker up and decreasing the value moves the marker down. 

Function 

This allows the user to set advanced settings for the TLM-170K, such as the scan mode, the aspect 
ratio, underscan mode, H/V delay, check field, zoom, and etc. Details of how these functions can 
be configured are described as follows: 

Scan 
This sets the Scan mode of the TLM-170K.  

Zoom: Enlarge the original image according to the zoom ratio of the TLM-170K. 

Aspect: Display the image according to the aspect ratio of the TLM-170K.   

Pixel to Pixel: Display the original image resolution without scaling to match a certain resolution or 
an aspect ratio. For example, when the resolution of the input video is 1920x1080 but the 
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monitor’s resolution is only 1280x800, only area equivalent to 1280x800 out of 1920x1080 will be 
displayed.  

Aspect 
The aspect control allows you to manually set the aspect ratio of the monitor. You should choose 
the aspect ratio of your screen to match that of the input video in order to achieve the best 
viewing experience. Views of different aspect ratios on the TLM-170K are shown in the diagram 
below. 

Note: Aspect ratio control is disabled if the scan mode is set to pixel to pixel.  

 
 

Overscan 
If enabled, the image rendered on the display will be larger than the physical area of the screen, 
creating a cropped image on the monitor screen.  
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H/V Delay 
Used to monitor the blanking area for H sync and V sync.  

In H delay mode, the horizontal sync is delayed so that the horizontal blanking period is displayed 
on the screen. 

In V delay mode, the vertical sync is delayed so that the vertical blanking period is displayed on the 
screen. 

In H/V delay mode, both horizontal and vertical syncs are delayed, resulting in both horizontal and 
vertical blanking periods being shown on the screen.  

Note: H/V Delay is disabled if the scan mode is set to pixel to pixel. 

Check Field 
The check field function offers the user Red-Only, Green-Only, Blue-Only and Mono modes for 
screen calibration should you require them.  

 

First turn on the color bar, then turn on the single color mode in the check field as this allows you 
to do the screen calibration by adjusting the brightness, contrast, saturation, tint and sharpness.   

Zoom 
The zoom function allows you to enlarge the image by a certain percentage (10 – 90%).  

Note: Zoom control is disabled if the scan mode is set to pixel to pixel.  

Freeze 
The monitor’s screen freezes once enabled.  

Waveform 

The TLM-170K also allows the user to display the image alongside with different monitoring 
waveforms such as the waveform, vector scope, histogram and audio level meter.  
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Image quality can be improved using tools such as peaking filter, false color and zebras.  

Waveform 
The TLM-170K offers users different waveform options listed as follows:  

• Muilt (vector scope, YCbCr waveform monitoring, histogram and audio meter) 

• Y (Y waveform monitoring) 

• YCbCr (YCbCr waveform monitoring) 

• RGB (RGB waveform monitoring and histogram) 

• Off 

 

Note: If Waveform is set to Multi, the Histogram is enabled by default.  

Vector Scope 

The vector scope is used to measure the color information 
such as Hue and Saturation in a video image.  

Note: For color bars, the vector scope works with 100% color 
bars and 75% color bars with a 75% white level.   

Hue: The color markers are red, magenta, blue, cyan, green, 
and yellow. The proximity a signal to one of the markers tells 
you what color it is.  

Saturation: A vectorscope shows you how saturated your 
color is and how far away the signal is from the center 
indicates how saturated the color is. For example, if the color 
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is close to one of those boxes, then that means that color in the image is very saturated.  

Intersecting lines: The line going up towards the yellow and red colors is the skin tone line on 
which the skin color should fall regardless of the person’s race. 

Waveform Monitoring 
Waveform monitoring consists of RGB and YCbCr waveforms which are used to measure the 
brightness, luminance and chroma of a video signal as shown in the diagram below. 

 

Waveform monitoring not only warns the user of out-of-range conditions such as overexposure but 
also serves as a good tool for color correction and white and black balance.  

Vector 
This enables/disables the vector scope.  

Transparency 
This selects the transparency of the waveform and vector scope.  

• 50% blend effect 

• 25% blend effect 

• Off: Opaque 

Peaking filter 
The peaking filter, once enabled, will place color lines on edges of the subject of the focus in the 
image. This function works well if the subject of the focus is correctly exposed for high contrast. 
Red, Green, Blue, White and Black are the five available outline colors on the TLM-170K.  

The Peaking Level determines the sensitivity of the filter. Setting the peaking level to a high value 
means more areas will be highlighted including lower contrast areas. If the peaking level is set to a 
low value, then only areas of high contrast will be highlighted. 

The diagram below illustrates images with peaking filter applied to the subject of the focus. Note 
the different colors of the outline in each picture.  
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False Color 
Also known as the exposure assist, once enabled, the false color feature will change colors of the 

elements of the image based on the brightness value. This allows the user to use the monitor’s 

exposure function to achieve proper exposure without the use of costly external equipment.  

To best utilize this feature, you must first understand the color chart below. The color chart is like a 

color scale. The exposure level is represented by different colors which correspond to the 

respective luminance of the pixels as displayed on the monitor. The correct exposure ranges from 

10 – 100%. Anything below 10% is regarded as underexposed and if exposure exceeds 100%, it is 

deemed overexposed.  

Underexposure and overexposure will lead to loss of details in an image.  
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For example, areas with exposure level of 56IRE when applied the false color will be shown as pink 
color on the monitor. Therefore, as you increase the exposure, that area will change color to grey, 
then yellow and finally to red if overexposed. Blue indicates underexposure. 

An example of an original image with the false color applied is shown on the left of the image 
below.  

 

The four available false color modes are Default (Normal), Spectrum, ARRI and Red, which are 
illustrated in the diagram below.  

 

False Color Table 
This enables/disables false color chart on the screen. A sample of the chart is shown below. 
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Exposure 
Once the exposure function is turned ON, you will be able to see a zebra pattern superimposed 
over parts of the image that are exposed to a specific level. In this way, the exposure of the image 
displayed on the screen can then be adjusted accordingly on the monitor by changing the exposure 
level (50 – 100 IRE).   
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Histogram 
The histogram is a great tool that helps you to improve the overall exposure of the image.  

Y (Luminosity) 
The Y or luminosity histogram is a graph that describes the human-eye perceived brightness 
distribution within an image.  

To produce the luminosity histogram, first break an image into individual pixels, then each pixel is 
converted so that it becomes a luminosity based on a weighted average of the three colors at that 
pixel. The green, red, and blue channels account for 59%, 30% and 11% of the perceived luminosity 
respectively. This is because human eye is more sensitive to green light than it is to blue or red 
light. Finally the luminosity histogram is produced by counting how many pixels are at each 
brightness level as shown in the diagram below.  

 

RGB 
The RGB histogram is a graph that represents the overall brightness of the entire image.  

In any digital image, each individual color is made by combining red, green and blue lights with 
each light represented by its brightness level ranging from 0 to 255. Therefore every color 
produced in this way has a specific brightness value based on mixes of red, green and blue 
throughout the image and these brightness values of all the different colors in an image are 
represented in a histogram which is known as the RGB histogram.    

On the TLM-170K, the RGB histogram is shown with the color overlay as depicted in the diagram 
below.  
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Color 
By setting the histogram to color, you will see one red histogram, one green histogram and one 
blue histogram. Each color histogram is basically a representation of how that color’s intensity is 
distributed throughout an image, allowing you to evaluate the brightness and exposure of that 
individual color channel.  See the diagram below for an example of the color histogram.  

 

Time Code 
The TLM-170K is able to decode the following SMPTE timecode formats:  

• LTC: Linear timecode. 

• VITC: Vertical interval timecode.  

The decoded time code will be shown at the top of the screen.  

Note: Time code is only available with the SDI input.  
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Audio 

Volume and Level Meter 
The Volume option sets the audio level of the input video, which can be viewed visually on the 
TLM-170K by enabling the Embedded Audio Level Meter.  

 

Note: If the monitor is in SDI mode, you will see 16 SDI embedded audio channels; in HDMI 
mode, there will be 8 HDMI embedded audio channels.  

Audio Vector 
Enable the audio vector scope shown below to view the audio information.  

 

Audio Vector CH (HDMI) 
First enable the audio vector scope, then select an audio input channel pair to view the audio 
information.   

Audio Vector CH (SDI) 
First enable the audio vector scope, then select an audio input channel pair to view the audio 
information.   

Audio Left Out 
Assign an audio channel to the left audio output channel.  
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An SDI input supports up to 16 embedded audio channels and an HDMI input supports 8 
embedded audio channels.  

Audio Right Out 
Assign an audio channel to the right audio output channel.  

An SDI input supports up to 16 embedded audio channels and an HDMI input supports 8 
embedded audio channels. 

System 

In the System sub menu, you will be able to do the following:  

1. Change the language of the OSD menu 

2. Turn on the color bar 

3. Set the OSD ON time 

4. Flip the image 

5. Select color calibration 

6. Switch the standby power mode  

7. Reset the entire device’s settings 

Language 
The available languages are English, Traditional Chinese and Simplified Chinese.  

Color Bar 
Available options are listed as follows: 

OFF: disables the color bar 

75% or 100% color bar 

Color Bar Mode 
The TLM-170K offers three color bar modes listed as follows:  

• REC601: SD video 

• REC709: HD video 

• BT2020: 4K or 8K video 

OSD Timer 
This sets the OSD menu’s ON time; the OSD menu will be automatically turned off after the timer 
times out.  

• 10s 

• 20s 

• 30s 

OSD Transparency 
This sets the OSD menu transparency. You can set the transparency level to either 25% or 50%. 
Disabling this option will yield an opaque OSD menu.  



 

35 
 

OSD H Position 
This adjusts the horizontal screen position of the OSD menu.  

OSD V Position 
This adjusts the vertical screen position of the OSD menu.  

Fan 
This allows you to turn ON/OFF the monitor’s built-in fan. If you set this option to Auto, the fan will 
be turned ON if the monitor is overheated.    

Color Calibration 
To use this feature, you will need to purchase Light Illusion’s LightSpace Color Management System 
(CMS) which includes a calibration probe and the CMS software. The TLM-170K works with CAL, 
PRO and XPT versions only. Visit https://www.lightillusion.com/lightspace.html for more 
information. 

See the CMS Color Calibration Process in the subsequent chapter.  

Comparison EN 
By enabling this option, you will be able to see the difference between the original image and the 
image with the selected color setting applied as illustrated in the diagram below. 

 

Gamma HDR 

Original Color Space 

Original Camera Log 

Reset 
Select ON to reset the device entirely.  

 

 

 

 

 

 

 

https://www.lightillusion.com/lightspace.html
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5. Color Management System – Calibration Process 

This chapter will discuss the use of Light Illusion's CMS software for color correction.  

Device Setup 

1. Before starting the calibration process, you need to install and register the CMS software first. 

Copy and paste the link https://www.lightillusion.com/colourspace.html into your browser’s 

address bar then hit enter to open the ColourSpace page shown below. 

 

https://www.lightillusion.com/colourspace.html
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Note: There are different versions of the CMS software. Make sure you download the right 

version for your calibration device, for example, the LTE version is for Datacolor Spyder4/5, Eizo 

Internal, i1 Display Pro OEM, i1 Display 1/2/LT and i1 Pro 1/2. You will need higher versions for 

Minolta CA-310 and Klein series.  

Click the link  https://www.lightillusion.com/i1display_pro.html to purchase i1Display Pro OEM 

colourimeter.  

Click the link https://www.lightillusion.com/murideo_six-g.html to purchase 4K & 8K signal 

generator. Please note that the signal generator is optional.  

2. Connect the calibration device to the PC or the laptop then the TLM-170K monitor via the HDMI 

interface. Enable Extended Desktop Mode on the PC or the laptop. Finally, open your graphics 

control panel to set the HDMI output to Full Range. The Intel HD Graphics Control Panel is 

shown in the diagram below for illustrative purposes.   

 

3. After you’ve successfully installed the CMS software, double click the icon below to open the 

software.  

 

 

 

https://www.lightillusion.com/i1display_pro.html
https://www.lightillusion.com/murideo_six-g.html
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The CMS software interface is shown below. 

 

Please note that the monitor must be warmed up before calibration. Turn ON the monitor and the 

color calibration device and leave them running for about 30 minutes. You can start color 

calibrating your monitor after you’ve completed the device setup.  

Software Setup 

1. Select the connected “Probe” 

Follow the path “Tools → Discoverable Probes” to access the color calibration devices supported 

by the CMS. Select the color calibration device that is connected to the PC or the laptop. The 

software setup guide will use i1Display Pro OEM for illustrative purposes.  
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2. Establish communication with the “Probe” 

Because the CMS software does not establish connection with the color calibration device 

automatically, you will need to manually establish communication between the Probe and the PC.  

Select “Tools → Calibration → Calibration Interface or Display Characterization”  

 

The CMS should detect the probe and a dialogue box with the message “Do you want to connect 

to i1 Display Pro”should pop up.  

Note: If the probe model is CA-310, you should see the corresponding model number in the 

message.  

Click “OK” if the detected color calibration device is correct.  

 

3. Warm up the monitor before calibration. 

Make sure the monitor and the color calibration device are turned ON and leave them running for 

about 30 minutes. 

4. Enable the TLM-170K monitor’s color calibration mode. 

Open the TLM-170K’s OSD menu, then select System → Color Calibration → ON.  
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5.  Luminance calibration (adjust the backlight). 

On the CMS User Interface, click Tools → Calibration → Calibration Interface to open the 

Calibration Interface window then click the Options button to open the window below.  

 

Locate Patch Scale pane (circled in red in the diagram above), then enter 16 in min and 235 in max.  
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Open the TLM-170K’s OSD menu to adjust the monitor’s 

backlight value and click the Update button in the 

Luminance Units pane located at the top right of the 

window above.  

As soon as the Update button is clicked, the Calibration 

Status window will appear along with the Calibration Area 

and a dialogue box. Drag the Calibration Area to the TLM-

170K. Lastly, point the probe at the calibration area as 

close as possible then click the OK button in the dialogue 

box to start calibration.  

 

Repeat the process until the MAX value in the Luminance Units pane is in the range of 80 – 120. 

Note that the closer the MAX value to 100, the better the TLM-170K is calibrated. 

6. Color calibration 

On the Display Characterization window (Tools → Calibration → Display Characterization), slide 

the Select Cube Side slider to 21 so that the Total Frames measured are 9261. Set Patch Sequence 

to Sequential and Select Time per Frame to Closed Loop Mode.  
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Click the Measure button, the Calibration Status window will appear along with the Calibration 

Area and a dialogue box. Drag the Calibration Area onto the TLM-170K. Lastly, enter a name for 

this particular calibration in the dialogue box, point the probe at the calibration area as close as 

possible then click the OK button to start calibration. Please note that it takes approximately one 

hour to perform 9261 point measurements.  
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7. Create a 3D Cube Color Calibration File 

Click Tools → Colour Space → Convert Colour Space 

to open the Convert Colour Space window. In the 

Source pane, select Rec709 for the color space and in 

the Destination pane, select the color space 

generated in the previous step.  

In the Name textbox, enter the name of the 3D cube 

color calibration file. The rest of the settings should 

be configured as shown in the diagram on the left. 

Click Create New button to generate the color 

conversion data.  
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Now click “File → Export” then select the “[3D] DaVinciResolve33 (*.cube)” format. Lastly click 

the Export button to export the 3D Cube file to a USB thumb drive. 

 

Settings and file exports of the DCI-P3 and BT2020 color spaces are depicted in the diagrams below.  

DCI-P3 
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BT-2020 

 

8. Import the 3D Cube file to the monitor 

Rename the three exported 3D cube files (REC709, DCI-P3 and BT2020) to “User1.cube”, 

“User2.cube” and “User3.cube” respectively and save them on a USB thumb drive. Insert the USB 

thumb into the SERVICE port of the TLM-170K and you will be prompted whether to write the 3D 

CUBE file to the monitor. Select “Yes” to write the 3D Cube file to the monitor. The color calibration 

process is complete after the 3D CUBE file has been written to the monitor successfully.  

Lastly, open the TLM-170K’s OSD menu, select “PICTURE” → “User Log” then select the 3D CUBE 

file imported previously.  
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6. Firmware Update 

Datavideo usually releases new firmware containing new features or reported bug fixes from time 

to time. Customers can either download the TLM-170K firmware as they wish or contact their local 

dealer or reseller for assistance.  

This section outlines the firmware upgrade process which should take approximately 20 minutes 

to complete.  

The existing TLM-170K settings should persist through the firmware upgrade process, which 

should not be interrupted once started as this could result in a non-responsive unit.  

Successful firmware upgrade on TLM-170K requires: 

➢ Latest TLM-170K firmware version 

➢ USB 2.0 Portable Drive (Max. 16GB) 

➢ USB A Cable 

To update the TLM-170K firmware 

MCU 

1. Unzip / extract the firmware file. 

2. Rename the bin file to “mcu.bin”. 

3. Format the USB 2.0 pen drive to FAT32.  

4. Copy mcu.bin to the USB 2.0 pen drive. 

5. Power off the TLM-170K (On/Off Switch at the back of the monitor) 

6. At the back of the monitor, plug the USB 2.0 pen drive into the USB 2.0 port labelled 

SERVICE. 

7. Power ON the TLM-170K while pushing down the EXIT key.  

8. Release the EXIT key when the F1 button LED starts flashing (the firmware is being 

updated). The TLM-170K should reboot automatically after the update is complete.  

9. To check the firmware versions, push down the EXIT key for 3 seconds then release; push 

down the MENU key for another 3 seconds then release; push down the EXIT key for 

another 3 seconds again to show the firmware versions on the OSD menu.  

 



 

47 
 

FPGA 

1. Unzip / extract the firmware file. 

2. Delete the contents of the USB 2.0 pen drive so it is empty. 

3. Copy the fpga.bit to the USB 2.0 pen drive. 

4. Plug the USB 2.0 pen drive into the USB 2.0 port labelled SERVICE on the back of the 

monitor. 

5. “Load FPGA…” appears on the screen as soon as the TLM-170K detects the fpga.bit file. 

6. fpga.bit is automatically loaded on the TLM-170K. 

7. The TLM-170K reboots itself after fpga.bit is successfully loaded.  

8. The firmware update is complete if the TLM-170K Monitor reboots successfully. 
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7. Dimensions 
 

 

 

 

 

  
 

 

 

All measurements in millimeters (mm) 
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8. Specifications 
 

LCD Display 

Size 17.3 inch 

Resolution 3840 × 2160 

Pixel Pitch 0.0995 x 0.0995 

Brightness 300 cd/m² 

Contrast Ratio 1000 : 1 

View Angle (Typ.) 178°(H) / 178°(V) 

Interface 

Video Inputs 1 x 12G SDI, 1 x HDMI (2.0) 

Video Loop Through OUT 1 x 12G SDI, 1 x HDMI (2.0) 

Audio Inputs Embedded Audio (48KHz sampling) 

Audio Outputs 
Analog stereo (Phone Jack) 

Speaker x 2 (3W) 

Tally 1 x Tally port 

Firmware Update USB 2.0 

Power In (12V) 
1 x XLR 

1 x Phoenix terminal (Pitch 5.08mm) 

Standard 

SDI Signal Format 

4096x2160p (23.98/24/25/29.97/30/50/59.94/60) 
3840x2160p (23.98/24/25/29.97/30/50/59.94/60) 
4096x2160Psf (23.98/24/25/29.97/30) 
3840x2160Psf (23.98/24/25/29.97/30) 
1920x1080p (23.98/24/25/29.97/30/50/59.94/60) 
1920x1080i (50/59.94/60) 
1920x1080Psf (23.98/24/25/29.97/30) 
1280×720p (23.98/24/25/29.97/30/50/59.94/60) 
525i, 625i 

HDMI Signal Format 

4096x2160p (23.98/24/25/29.97/30/50/59.94/60) 
3840x2160p (23.98/24/25/29.97/30/50/59.94/60) 
1920x1080p (23.98/24/25/29.97/30/50/59.94/60) 
1920x1080i (50/59.94/60) 
1280×720p (23.98/24/25/29.97/30/50/59.94/60) 
720 x480i (NTSC), 720 x576i (PAL) 
640 x800, 800 x600, 1024 x768, 1280 x800 
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General 

Power 12V/40.1W (12V/5A) 

Operating Temperature 0°C to 40°C (32°F to 104°F) 

Storage Temperature -20°C to 60°C (-4°F to 140°F) 

Humidity 10% to 80% (non-condensing) 

Dimension (mm) 403(L) × 305(W) × 36.6(D) 

Weight 4.1 Kg 
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Notes 
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Service and Support 
 

www.datavideo.com/product/TLM-170K  
www.datavideo.com/product/TLM-170KM  
www.datavideo.com/product/TLM-170KR  

Datavideo Technologies Co., Ltd. All rights reserved 2020 

 

Dec-24.2025 

Version E5 

http://www.datavideo.com/product/TLM-170K
http://www.datavideo.com/product/TLM-170KM
http://www.datavideo.com/product/TLM-170KR
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